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Huntron Workstation software 
 
It is very helpful if you have a working knowledge of Microsoft Windows prior to using Huntron 

Workstation. 

You are allowed to create a backup copy of the software disk. Your purchase agreement allows for 

copies to be made for backup purposes only -  copying for distribution or resale is strictly 

prohibited.   

 

Installation Instructions 

Install the software BEFORE connecting any hardware. Uninstall any previous versions prior to 

loading the current version. For more installation details follow the “Getting Started” sheet 

included with your Huntron product. 

Uninstall any previous versions of Workstation prior to installing the new version. 

Insert the Huntron Workstation CDROM. The CDROM should Autorun and begin the installation 

process. If your PC has Autorun disabled then browse Window and select WorkstationSetup.exe. 

This will begin the installation process. During the install you will be asked to install additional 

software for Access Probers. Select the appropriate response based on your Prober hardware. 

 

Installation of Additional Support Software 

Installation of software for the support of supported digital multimeters (DMM) will be required for 

the proper operation and control. 

 

Keysight/Agilent 34410A/34461A, B&K Precision 2841 

 

Insert the Keysight IO Libraries Suite CD or download the software from keysight.com. Run the IO 

Libraries Suite installer. The install process should begin. Use default selections as prompted 

during the installation process as there are no special conditions needed for the DMM hardware. 

 

If the Agilent 34410A is being used copy the “HuntronExternal4.dll” file from the path 

“C:\Program Files (x86)\Huntron Workstation 4.3\E4DMM34410A” to the path “C:\Program Files 

(x86)\Huntron Workstation 4.3”. Select “Yes” to overwrite the existing “HuntronExternal4.dll” file 

in that path. If the KeySight (Agilent) 34461A is being used copy the “HuntronExternal4.dll” 

file from the path “C:\Program Files (x86)\Huntron Workstation 4.3\E4DMM34461A”.  

If the B&K Precision 2841 is being used copy the “HuntronExternal4.dll” file from the path 

“C:\Program Files (x86)\Huntron Workstation 4.3\E4DMM2841”. 
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Note: If you are using a 32bit version of Windows, the files will be located in a “Program 

Files/Huntron Workstation” folder. 

 

Tektronix DMM4050 

If the Tektronix DMM4050 is being used copy the “HuntronExternal4.dll” file from the path 

“C:\Program Files\Huntron Workstation\E4DMM4050” to the path “C:\Program Files\Huntron 

Workstation”. Select “Yes” to overwrite the existing “HuntronExternal4.dll” file in that path. If you 

are using Windows Vista 64bit or Windows 7 64bit, the files will be located in a “Program Files 

(x86)/Huntron Workstation” folder. 

 

Hardware Setup 

If a Huntron Access Prober is being used, connect it to power.  

Connect the Huntron Access to the PC with the USB Cable. 

Connect the DMM to Power. 

Connect the DMM to the PC using the USB cable. 

Connect the DMM to the Huntron Access using the banana cables and BNC-to-banana adapters. 

Connect the INPUT HI banana jack using the red banana cable to the PROBE BNC. 

Connect the INPUT LO banana jack using the black banana cable to the COMMON BNC. 

 

 

Connect a Banana to Clip cable to the top black banana on the front of the Huntron Access. This 

will be used to clip on to ground on the board to make measurements.  
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Agilent 34410A 

Enable USB 

1. On the Front panel press the Shift and Data Log (Utility) button 

2. On the Menu select UTILITY MENU->REMOTE I/O->USB->ENABLE USB? 

3. Turn the DMM Off and Back On 

4. On the Front panel press Shift Data Log (Utility) button 

5. On the Menu select UTILITY MENU->REMOTE I/O->USB->ENABLE USB?->USB ID 

6. Verify that the USB ID starts with USB0::0x0957:0x0607 

7. The next part of the USB ID is the serial number that will need to be entered into Huntron 

Workstation. 

Keysight/Agilent 34461A 

Enable USB  

1. On the Front panel press the Shift and Display (Utility) button 

2. Select I/O Config 

3. Select USB Settings 

4. Set USB Front On 

5. Set USB SCPI On 

6. Set File Access Off 

7. Turn the DMM Off and Back On 

8. On the Front panel press the Shift and Display (Utility) button 

9. Select I/O Config 

10. Select USB Settings 

11. Select Show USB Id 

12. Verify that the USB ID starts with USB0::0x0957:0x1A07 

13. The next part of the USB ID is the serial number that will need to be entered into Huntron 

Workstation. 

B&K Precision 2841 

Enable USB 

1. Power ON the DMM 

2. Press the SETUP button 

3. Touch SYSTEM SETUP on the touch screen (right side) 

4. Touch BUS MODE on the touch screen (left side) 

5. Touch USBTMC on the touch screen (right side) 

6. Press the ENTER button 

7. Press the DISP button to return to the main display 
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Huntron Workstation Main Interface 

When starting Huntron Workstation for the first time, you will be prompted for an activation code. 

Type in the code exactly as it is presented on the installation CD. 

Use upper case letters and note the differences between the letter “O” and the number zero. 

 

 

 

The Main Window for Huntron Workstation 4 features a multi-pane layout so many aspects of the 

test creation and execution can be displayed at the same time. The Panes are interactive to a 

certain degree in that changes in one Pane will affect other Panes. The Panes can be resized, 

floated independently or “tabbed” to the sides of the window. The Status Bar displays information 

about items currently selected and status information while processes are running.  

  

Tree Pane 
- Test and editing 

Signature Pane 
- Signature display 
and scanning 

Prober Pane 
- Robotic Prober 
control 

Image Pane 
- Display of CAD 
layout and PCB 

images 

Status bar 

Tool bars 
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The Toolbar 

The Toolbar just under the application menus allows for quick access to several program functions. 

The function of each is broken out in the diagram below. 

12 

 

  1. 2. 3. 4. 5. 6. 7.  8.  9. 10.  11. 12. 13. 14. 15. 16. 17. 18. 19.  20. 21. 22. 

 

1. Create New Board database 13. Initialize Prober Home 

2. Open Board database 14. Connect/Disconnect Prober 

3.  Save As… 15. Clear Prober STOP condition 

4. Add New (Sequence, Component or Range) 16. Change Access DH/DH2 Probes 

5. Copy (Sequence, Component, Net or Range) 17. ON/OFF Access DH2 Interior Light 

6. Paste (Sequence, Component, Net or Range) 18. Connect/Disconnect Tracker 

7. Cut (Sequence, Component, Net or Range) 19. Previous Component or Net  

8. Delete (Seq., Comp., Net, Range or Scan) 20. Next Component or Net 

9. Build New (Sequence, Component) 21. Previous Pin 

10. Repeat New (Sequence, Component) 22. Next Pin 

11. Scan Component or Net 

12. Scan Sequence 
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Hardware Setup 

Turn on the Huntron Access and the DMM. 

Using your DMM front panel controls, verify that the DMM Port settings are correct. The typical 

settings for the Tektronix 4050 DMM will be: baud 9600, data 8, par no, stop 1 and echo OFF. All 

other supported DMMs are USB and do require port set up. 

When first starting Huntron Workstation, select Options from the Tools menu. The Options 

window is used to setup default settings used when working in Huntron Workstation.  

 

 

 

 

Select the General tab and set the desired Unit of Measure (use Microns for Huntron Access 

Probers, Mils for any other Prober). Also Select Compare Depth of Range. 

 

Select the Hardware tab and leave the type of Tracker hardware, the Tracker Port and Scanner 

options at none. 
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If an Access Prober is being used you will need to select the type of Access Prober, the port for the 

Prober and the Frame Grabber (camera) type. Select the prober Serial Port the Prober connection 

is using which will either be a COM port (older probers) or USB (newer Probers). Alternatively, go 

to the Windows Control Panel, select System and select Device Manager. Locate the Ports 

settings as shown in the image below. Use the COM number shown next to “HS-20USB”. Check 

the Access (2) USB Grey Camera checkbox if you have an Access 2 Prober where the camera has 

a grey colored body rather than black. 

 

Click the Connect button to initiate communication with the selected hardware.  
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Select the DMM tab that is available for your meter, DMM4050, DMM34410A, DMM34461A or 

DMM2841.  

For the Keysight/Agilent DMMs, select the correct USB VID PID for your model, set the Port for 

USB, Connection to None and input the serial of the DMM being connected. Click the Connect 

button to connect with the DMM.  

For the B&K Precision 2841, select the USB VID PID to 0x0471::0x2515, Port as USB, 

Connection set to None, and serial number as 482A16001. 

For the Tektronix 4050, set the Device to 1, and set the COM Port to the port being used by the 

meter (check the Device Manager for the correct COM port). 

Click the Connect button to connect to the instrument. 

 

 

 

Select the Sequence tab and uncheck the Enable Tracker checkbox and check the Enable 

DMM(your model number) checkbox. 
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Select the Range tab and check the box to enable only Range 1. Set the Range 1 Tester to your 

model of DMM and the Range 1 Delay to 0. 

 

Select the DMM tab (for your model) on the Range Tab. The settings available in this tab may 

vary depending on the DMM model used. You can set the plus and minus Tolerance amount, 

Measurement type (AUTO recommended), Volts range and nominal measurement value. 

Tolerance is controlled by the Comparison setting at the Range level. It can be in measurement 

units (i.e. volts, ohms, etc.) or by percentage. These are simply setting defaults for when you add 

new components to the test. You can change the values at any time.  

 

 

Click the Save (Permanent) button to save this configuration as the startup default. 
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Using Workstation with a DMM 

A DMM based test uses the concept of Test Points (TP). The Workstation Software has, for 

programming purposes, the concept of components and pins. When using with a DMM it is best to 

think of components as tests and pins as Test Points (TP). 

 

Creating a DMM Board Test 

There are a number of steps necessary to creating a DMM board test.  

 

Huntron Workstation Test Layout (Tree)

Board (creates an Access .mdb file)

Sequence (test set of Tests) 

Component (Test)  (name, Functional Test)

Pins (TPs) (name; U1.6, TP3, etc.)

Ranges (Measurement settings)

 

 

Example of Board Test Information: 

Board Name: Sample (creates “Sample.mdb” file) 

 Revision: (This field is optional) 

Sequence: DC Measurements  

Component (Test): Test Points 

Pins (TP): Per TP settings for X, Y, Z locations, etc… 

Ranges: Per TP measurement settings, tolerance, etc… 

The user has total discretion as to the information input into these fields. There is no “right” way 

as to what information is entered as every user’s situation will be different. The above example is 

just one way the information might be entered. 

Entering information into the Entry windows is very straight forward. The easiest way to move 

from field to field is by pressing the TAB key. You can also use the mouse to click into a particular 

field so you can enter information. 
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DMM Test Building Procedures 

- Determine TP Locations on the board and the tests to be performed 

- Create Test Database in the Tree Pane 

o Add Board, Sequence, and Components (Tests)  

If an Access Prober is being used: 

- Perform Camera Offset 

- Select Alignment points  

- Teach component pin (TP) 

Using the test: 

- Scan Sequences and Set References 

 

Listed above is a general outline on how you would proceed when preparing to test a board. As 

with any type of complex test equipment, practice makes perfect so take the time to learn and 

practice these procedures. 

 

Creating a Board Database 

 

 

To create a new Board, select New from the File menu or use the New button in the toolbar. Input 

information into the “Add New Board” dialog as needed. The only field that is required is board 

Name (Example ñSample ò). Other fields such as Revision, System, Unit, Manufacturer and Gold 

Disk Number can be completed with related information if desired. 
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Adding a New Sequence 

 

To add a new Sequence, select the Sequence tab in the Tree pane. Select Add New Sequence 

from the Edit menu or click the Add New button (+) in the toolbar. 

Details: 

Sequence Name Field: Enter Sequence name 

Slot field: Select the Prober slot that the board will be in when scanning. 

Compare Priority: Selects the comparison priority between Same (serial number), All (serial 

numbers; this is the recommended setting) or Min/Max (Merged min/max signatures) 

Instructions field: Enter any instructions or system information that you wish to pass on to 

future users. Note: the ENTER key in this field will work as a carriage return. 

The Add New, Repeat and Build buttons will allow for another new Sequence to be created 

saving the current one. 

The Delete button will erase the selected Sequence. 

 

Other functions within this window can be read about by clicking the HELP button. 

 

Select the Testers tab and check the Enable DMM checkbox for your model DMM. 
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Adding a New Component (Test) 

 

To add a new Component (Test), select the Component tab in the Tree pane. Select Add New 

Component from the Edit menu or click Add New button (+) in the toolbar. 

Details: 

Component Name field: Enter the component name (Test Name) in this field.  

Package and Number of Pins fields: The Number of Pins should be set to at least the number of 

TPs in this Test (component). Select more pins than the current number of TPs allows more TPs to 

be added later. For unused pins (TPs) uncheck the Scan Pin check box on the Pin Tab after the 

Component is created. 

Type field: This information is optional but you can enter the component type in this field.  

Pin Spacing: Not used with DMM tests. 

Connection Type: Set to Prober for Access Prober users 

Open Check Type: Not used with DMM tests 

Correction Steps: Sets the maximum amount of correction steps used with the Huntron Access 

Prober when moving to the first TP of the Test. 

Instructions field: Enter any instructions or component information that you wish to pass on to 

future users. Rich text images can be pasted into this field. 

Other functions within this window can be read about by clicking the HELP button. 

Pin Edit 

Settings for individual pins can be modified by open the Pin Edit window. You can open the Pin 

Edit window by selecting the Pin tab in the Tree pane, right-click the row header and select Edit 

Pin. 
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Name: Type directly into the Name field to change the pin name 

Net Name: Type directly into the Name field to change the Net name 

Correction Steps: Modifies the number correction steps used with Access Probers. This may need 

to be modified for very small pitch devices. 

Scan Pin: Enables or disables scanning of the selected pin 

Pause: Prober will pause and display Pin Instructions before scanning 

Other functions in this window are not used with DMM test systems. 

 

Modifying a Range (DMM Measurement Setup) 

When a new component (Test) is added to a Sequence default range(s) are added to each pin 

(TP). The defaults are set up in the Tools/Options/Range/DMM(XXXXX) tab. These settings 

need to be modified based on signal being measured at each TP. The goal is to obtain a good 

measurement at each TP. The test only stops after a component (test) is completed. 
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To edit a Range, select the Range tab in the Tree pane. Select Edit Range from the Edit menu or 

the quick menu shown above. The Edit Range dialog will be displayed. 

 

 

 

Select the Tree/Range tab to display 
the ranges for the selected 
component pin. RIGHT click on the 
row header (far left grey area of the 

row) to display a quick menu (shown 
left) 
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Edit Range Details (settings may be different  based on DMM model): 

Note: All of the settings can be modified directly in the Range grid.  

+Tolerance: The amount above the Reference or Nominal Reading which determines the High 

Pass Limit. This is used during comparison to the value listed in the Nominal field. This amount 

can be a value or percentage depending on the Comparison setting. 

-Tolerance: The amount below the Reference or Nominal Reading which determines the Low Pass 

Limit. This is used during comparison to the value listed in the Nominal field. This amount can be 

a value or percentage depending on the Comparison setting. 

Measurement: Sets type of DMM Measurement 

Range: Sets the DMM Range (AUTO recommended if available) 

Comparison: Sets the comparison mode. Nominal compares the measurement to the entered 

Nominal value. Reference compares the measurement to the stored reference measurements. 

Nominal % uses the Tolerance setting as a percentage of the Nominal value. Reference % uses 

the Tolerance setting as a percentage of the Reference value. 

Nominal: Enter the nominal value for the measurement. This is the value used when test 

Comparison is set to Nominal. 

NPLC: Sets the number of power line cycles before sampling. This setting can make certain 

measurements such as resistance more sensitive. 

Resolution and Samples are typically left blank so the DMM default is used. 

SCPI: Allows for additional SCPI commands to be set before a sample is taken. 

 

Using a Huntron Access Prober with a DMM 

The steps needed to use your DMM with an Access single or dual headed Prober is identical to 

those used with the Huntron Tracker. Refer to the full Huntron Workstation tutorial for Prober set 

up procedures. 
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Manual Modes 

 

 

Manual measurements can be obtained using the DMM(XXXXX) tab in the Signature pane. This 

pane may be useful when configuring test parameters for a Test Point (TP). Setup the 

Measurement parameters and click Get Reading to observer the measured signal. 

 

Scanning a Sequence or Component 

 

 

Select the Sequence or Component to be scanned in the Tree Pane. 

Select the Scan tab in the Signature Pane (shown above). 

Input a Serial Number into the Serial Number field; this will be the name of the scan. 
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The Stop On Failure check box will cause the scanning to stop if a component comparison fails. 

This is most useful when scanning known good boards to add as references. 

The Scan Continuous check box will cause the scan to go into a loop mode where it will scan 

without stopping until a signature comparison fails. 

Enable the Sequence checkbox to scan all of the components in the Sequence. 

The Use Scan List check box will add the ability to use a Scan List when the Scan Sequence 

dialog appears (see Creating a Scan List section). 

Press the Start button to execute the scan. 

The test instructions prompt will be displayed. Clicking OK will start the scan for probers 

 

Scan Results 

When a scan is complete, the results Passed, Failed or No Ref (No Reference) will be displayed 

(the text of the results message can be changed in the Tools/Options/General settings).  

If the Comparison type set at the Range level is set to Nominal or Nominal% then the 

PASSED or FAILED test result will be based on comparing against the Nominal value set for the 

Range. 
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Viewing Signatures – Troublesheet 

Click the Troublesheet button to view the test result based on a Nominal value. 

 

 

The component name will be display to the left in the Passed or Failed tab. The Deviation (Dev) 

shown in the signature box is the amount that the measured value deviates from the Nominal 

value plus the tolerances set for the range. 

 

If the Comparison type set at the Range level is set for Reference or Reference% then the test 

result will display NO REF (No Reference). 

 

 

The NO REF message will be displayed on the first scan of any test since there are no scans 

stored as Reference. 
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Clicking the Troublesheet button will display the signature differences in the Troublesheet tab of 

the Signature pane. 

Click the Set Reference button to make this measurement the comparison Reference for this 

test. 

 

When the test is executed again the result will compare against the stored Reference and display 

the result. Here is the Troublesheet for a Failed result. 

 

The measured value, the Reference value and the Deviation will be displayed in the Signature box. 
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Viewing Signatures Troublesheet Report 

To view and print the Troublesheet report, press the Print button in the Troublesheet window. You 

can select from several options including a Sequence or Component Level report, the level of 

detail and add problem and solution comments to the report. Click Preview to view the report on-

screen. 

 

    

 

 

The report can be printed or exported in several different formats including HTML and PDF by 

selecting File/Export Document in the Preview window. 
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Viewing Signatures in the Signatures Pane 

 

 

To view scanned signatures, select the Signatures tab in the Signature Pane. Signatures marked 

with an asterisk * indicate that this scan is set as a Reference. The Scan name, date and time will 

be displayed on the left side of the window and signatures on the right. The Scale buttons will 

change the number of columns displayed. Scaling the window will increase the number of 

signatures displayed. The Copy button will copy the signatures to the Windows clipboard so they 

can be pasted into another program (in a metafile format). The Print button will print the 

signatures in one of several different user selected formats. 
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Viewing Signatures – Right Click 

 

 

Additional options when viewing signatures can be displayed by right clicking in the signature 

area. 

Reprobe Pin Signatures: Will reprobe the selected test point and prompt to replace the previous 

measurement 

Real Time: Updates measurement in real time 

Get Signature: Capture signature 

Get Pin Signatures: Captures signatures for all of the displayed ranges 

Replace Signature: Replaces the stored signature with the current signature displayed for the 

selected pin, range and scan (shown in the Scan List to the left) 

Replace Pin Signatures: Replaces the stored signatures with the current signatures displayed 

for the selected pin, all ranges and scan – works only in Range Mode 

Sync Pin/Range: Selects pin and range in the Tree (see default in Tools/Options) 

Edit Range: Selects the pin and range in the Tree and opens the Edit Range dialog 

Disable Range: Disables the selected Range 

Edit Pin: Selects the Pin the in the Tree and opens the Edit Pin dialog 

Edit Comp/Net: Selects the Component or Net the in the Tree and opens the Edit dialog 

Teach Pin: Selects the pin the Prober Teach pane 

Teach Height Pin: Selects the pin the Prober Teach Height pane 
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Group Edit: Opens Group Edit dialog for editing of component pin parameters as a group 

Net Edit: Opens Net Edit dialog for editing of Net pin parameters as a group 

Sync CAD: Will link the selected signature to the CAD image displayed in the Image/CAD pane. 

Sync CAD will be disabled if there is no linked CAD data. 

Copy: Copies the current signature box to the clipboard 

Data: Not used with non-Tracker applications. 

Range/Pin Mode: Displays signature with Range priority or Pin priority; see default in 

Tools/Options). 

 

Component Scans Information 

 

 

Selecting the Scans tab in the Tree Pane will display all of the scans performed on the selected 

component in a table format. The Scan information displayed includes the serial number, 

operator, date/time, Merge setting (checked if this scan is included in the Merge set), Reference 

setting (checked indicates it is set as a comparison Reference), Pass status (will be checked if 

components passed comparison), Removed status (will be checked if component was removed 

from Troublesheet), Area number (highest of scanned pins), Deviation, Min/Max status and other 

settings (see Help for more information). 
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Component Scans – Right Clicking (Auxiliary menus)  

 

 

Right clicking on the Row bar of the Scan pane displays an additional menu for performing specific 

tasks such as deleting a scan for the selected components or all components. Enable Sequence 

Reference/Disable Sequence Reference will mark or unmark the selected scan as a reference 

(comparison) scan for all components in the Sequence. Delete Scan will erase the selected scan 

for the current component only. Delete Scan All Components/Nets will erase the selected scan 

for all components or nets in the Sequence. Load Troublesheet will display the selected scan in 

the Signature pane/Troublesheet tab. 
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Component Scans – Right Clicking (Auxiliary menus)  

 

 

Right clicking on the Column bar of the Scans pane displays an additional menu for performing 

specific tasks such as sorting or globally setting parameters. The menu will vary depending on the 

column selected. In the image above, the Reference column header was right-clicked. 

 

Component Scans – Right Clicking (Auxiliary menus)  

 

 



© Huntron, Inc 2019 Rev. C 28 

Right clicking on the Column bar of the Scans pane displays an additional menu for performing 

specific tasks such as sorting or globally updating items. In the image above, the Serial Number 

column header was right-clicked.  

 

Range Tab – Right-click Menu 

One very useful feature making quick global changes to range parameters is the menu available 

by right-clicking the column header (the title area directly above the column) in the Range tab. 

 

 

After making a parameter change for the range, right-click the column header for that parameter 

as shown in the image above to display the menu. The most useful selection is Set Current 

All/Pins where all of the pins of the component will be modified to the same setting as the 

selected Pin. This menu is available for most Range parameters. Remember to make the 

parameter change first then use Set Current All/Pins.  
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Sequence/Component/Pin Editing – Right Click menus  

 

 

Right clicking on the Row header bar of the Tree pane displays an additional menu for performing 

specific tasks such as Add New, Insert, Delete, Repeat, Build (repeat but with name 

incremented by 1), Copy, Paste and Cut. Right clicking works at all levels of the Tree pane 

including Sequence, Component (shown above), Pins, Ranges and Scans. The Sync CAD option 

available at the Component and Pin levels will synchronize the selected component or pin to the 

CAD image in the Image pane. 

It is also possible to select groups of components by holding the SHIFT or CTRL keys while 

selecting components in the Tree. To copy, paste, cut or delete groups of components, use the 

Copy, Paste, Cut or Delete Toolbar buttons below the main menu.  
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Pin Editing – Right Clicking (Auxiliary menus)  

 

 

Right clicking on the Row header bar of the Tree/Pins pane allows for editing of the pin 

information. Select Edit to open the Edit window for the selected pin. 

Note: Some Pin settings can also be edited directly in the Pins grid by clicking the appropriate field 

and modifying the setting.  

Group Edit and Net Edit allow you make changes to the pin of a component and have those 

modifications also change components that have the same number of pins within the same 

Sequence.   

 

 

 

 

Change the desired settings for the 

current Pin first then select Group 

Edit from the right-click menu (see 

above). Components with the same 

number of pins will be listed. Select 

the components and pins you want to 

be changed. Select the Pin Settings 

check box(s) for the setting(s) you 

want changed. Check the Ranges box 

to match the ranges (this will cause 

signatures to be deleted). Click the 

Update Pins/Ranges button to 

make the changes. 


